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NerveCenter 4.0.3 Release NotesNerveCenter 4.0.3
Open NerveCenterTM is a proactive event correlation application that intelligently filters network 
events, automates corrective actions, and forwards important events to a network management 
platform. 

A site can move directly to NerveCenter 4.0.3 from any NerveCenter 3.8 or 4.0 release, patch, or 
hotfix.

Please read New Features and Fixes on page 14 for information about what new features 
NerveCenter 4.0.3 contains.

Read This First
Disclaimer: These release notes are for use with NerveCenter 4.0.3 and supersede all existing 
documentation.

The models provided with NerveCenter 4.0.3 are for demonstration use only, and are not intended 
for production.
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Requirements
Requirements

This section describes the hardware and software requirements to install NerveCenter 4.0.3 and 
contains the following:

Software Requirements

Hardware Requirements

Software Requirements
This section describes the operating system requirements to install NerveCenter 4.0.3, and the 
version requirements for integration with Network Management platforms such as Hewlett-
Packard OpenView.

Operating System

Network Management Platforms

Web Servers

Web Browsers

Operating System
NerveCenter 4.0.3 works with the following operating systems. See the following sections for 
details about operating system requirements:

HP-UX

Linux

Solaris

Windows
NerveCenter 4.0.3 Release Notes2



Software Requirements
HP-UX
HP-UX 11.0 with the following recommended patches:

PHSS_27230: s700_800 11.00 X/Motif 32bit Runtime Periodic Patch

PHSS_24627: aCC 3.33 (or PHSS_26945 for aCC3.37)

TIP
QPK1100 B.11.00.62.4 patch bundle includes PHSS_27230 and PHSS_26945.

CAUTION
For HP-UX 11.0 you must increase file handles to 200.

NOTE
If you are running HP OpenView 7.01, you need the following additional patches:
PHKL_25613: IDS/9000; file/socked syscalls; eventports
PHKL_24064: eventport (/dev/poll) pseudo driver

NerveCenter requires a CDE desktop installed.

The machine should have a fixed IP Address and Hostname.

You must upgrade your browser to at least Netscape 7 or Mozilla 1.6

To view the help, you must specify a path to a supported web browser when installing 
NerveCenter. See Installing NerveCenter on UNIX in Installing NerveCenter for details.
NerveCenter 4.0.3 Release Notes 3



Requirements
Linux
RedHat Enterprise Server 3.0 with the most recent recommended patches.

X-Windows software with Motif or CDE to run the following NerveCenter components: 
Client, Administrator, and SerializeDB. 

An X server must be installed but does not have to be running to run the following 
NerveCenter components: Server, Command Line Interface (CLI), Importutil, and IPSweep.

The DISPLAY variable must point to a valid X display for the following NerveCenter 
components: Client, Administrator, IPSweep, and SerializeDB

NerveCenter requires a Gnome desktop installed.

The machine should have a fixed IP Address and Hostname.

You must upgrade your browser to at least Netscape 7 or Mozilla 1.6

To view the help, you must specify a path to a supported web browser when installing 
NerveCenter. See Installing NerveCenter on UNIX in Installing NerveCenter for details.

Solaris
Solaris 8 with the following recommended patch:

Most recent Recommended Patch Bundle for Solaris 8 

NOTE
NerveCenter no longer functions after applying the Solaris Recommended Patch 
Bundle for Solaris 8 dated June 27, 2003. The following error message appears in 
the ncserver.log file in the /tmp directory located in NerveCenter home directory. 

Assertion failed: 0, file ../lnk/throw.cc, line 366 

If you have not yet installed this patch bundle, you can comment out patch 109147-
24 from the patch_order file that is processed by the install_cluster script. If you 
have installed this patch bundle, back out patch 109147-24. For further information 
about patch 109147-24, please visit Sun's website. 

X-Windows software with Motif or CDE to run the following NerveCenter components: 
Client, Administrator, and SerializeDB. 

An X server must be installed but does not have to be running to run the following 
NerveCenter components: Server, Command Line Interface (CLI), Importutil, and IPSweep.
NerveCenter 4.0.3 Release Notes4
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Software Requirements
The DISPLAY variable must point to a valid X display for the following NerveCenter 
components: Client, Administrator, IPSweep, and SerializeDB

NerveCenter requires a CDE desktop installed.

The machine should have a fixed IP Address and Hostname.

You must upgrade your browser to at least Netscape 7 or Mozilla 1.6

To view the help, you must specify a path to a supported web browser when installing 
NerveCenter. See Installing NerveCenter on UNIX in Installing NerveCenter for details.

Windows
Windows XP Professional with the following recommended service pack:

Service Pack 2

Windows 2000 Professional and Server with the following recommended service pack:

Service Pack 4

Windows 2003 Server with the following recommended service pack:

Service Pack 1

The machine should have a fixed IP Address and Hostname.

NerveCenter is also compatible with the following databases:

MS SQL 7.0

MS SQL Server 2000

If NerveCenter uses a SQL Server database, the database must be case insensitive.

Microsoft BackOffice v2.5 requires Microsoft Windows NT 4.0 Server for SQL Server.

Microsoft Access

ODBC 3.5 and 3.6
NerveCenter 4.0.3 Release Notes 5



Requirements
Network Management Platforms
NerveCenter 4.0.3 can be used as a stand-alone system or in conjunction with the following 
network management platforms:

HP OpenView Network Node Manager 6.2 or above

HP OpenView Network Node Manager 7.0

NOTE
OVPA, the integration component of NerveCenter for HP OpenView is not 
supported on Linux.

IBM NetView 7.13 (Solaris and AIX 5.1)

CA Unicenter TNG 2.1

If NerveCenter uses a SQL Server database, the database must be case insensitive, the 
default. CA Unicenter users should be aware that Unicenter uses a case sensitive SQL 
Server. Therefore, when integrating NerveCenter with CA Unicenter a separate SQL Server 
database should be used.

Tivoli TME 10

Micromuse Netcool/OMNIbus 3.3

For integration to be complete, Netcool/OMNIbus must include the NerveCenter probe 
provided by Micromuse (nc probe version 64 rev 1). For more information, contact your 
Micromuse representative.

NOTE
SEMSOPCA, the tool used to integrate with HP OpenView IT/Operations A.04.00, 
is provided for historical purposes only. It is depreciated and not supported.
NerveCenter 4.0.3 Release Notes6



Software Requirements
Web Servers
This version of NerveCenter is compatible with the following web servers:

Apache 1.3.x and 2.0.x for Solaris and HP-UX

Microsoft Internet Information Server (IIS) 5.0 (Windows 2000), ISS 5.1 (Windows XP) 
Web Browsers

The following web browsers can be used with the NerveCenter Web Collector:

Microsoft Internet Explorer 5.5 and 6.0 (Windows only)

Netscape Navigator 7.0 or above

Web Browsers
To use the Open NerveCenter online documentation and help, you may use the following browsers:

Internet Explorer 4.0, 5.0 or 6.0 or above

You must configure Active Content to run on your machine with Internet Explorer version 6. 
Select Tools > Internet Options > Advanced > Security. You must enable the following 
option for the search to work: Allow active content to run in files on My Computer.

Mozilla 1.6 or above

Netscape Navigator 7.0 or above

NOTE
To view the help, you must specify a path to a supported web browser when 
installing NerveCenter on UNIX. See Installing NerveCenter on UNIX in Installing 
NerveCenter for details.
NerveCenter 4.0.3 Release Notes 7



Requirements
Hardware Requirements
Following is a table listing the minimum hardware configuration required for the system running 
NerveCenter 4.0.3. The figures assume the machine is running the base operating system and 
NerveCenter only.

The process /usr/sbin/rpcbind must be running on UNIX systems for the NerveCenter Server 
to start.

HP-UX systems also require 25 MB RAM in the /tmp directory.

TABLE 1-1. Minimum Hardware Requirements

HPUX Solaris Linux and Windows

512 MB RAM; 1024 MB Swap 512 MB Ram 512 MB RAM 

440-MHz PA-8500 2.0 450 MHz UltraSPARC-II module 1 GHz Intel Processor

20 GB disk space 20 GB disk space 20 GB disk space

Color monitor, 1024 x 768, 256 colors Color monitor, 1024 x 768, 256 colors Color monitor, 1024 x 768, 256 colors
NerveCenter 4.0.3 Release Notes8



Additional Step for First-time, OVPA-only Installs
Installation

Installation instructions for NerveCenter can be found in the book Installing NerveCenter available 
at the root of the CD as install.pdf.

CAUTION
Before installing NerveCenter 4.0.3, you should read the sections New Features 
and Outstanding Issues for important information about behaviors that require 
additional explanation.

If you are upgrading from a previous version of NerveCenter, see Upgrading 
NerveCenter.

For other information about NerveCenter see the documentation, available in the 
NerveCenterInstallPath/docs directory or the Client or Administrator Help.

Additional Step for First-time, OVPA-only Installs
For a first-time, OVPA-only install, users must add one or both of the following two lines to their 
local /etc/services file (or the /etc/services file on the NIS server, if running NIS):

nl-nc-opc-adapt 6028/tcp

nl-nc-plat-adapt 6024/tcp

The first line applies to Operations Center and ITO adapters. The second line applies to OpenView 
platform adapters. Editing the services file requires root privileges on the host platform.

If you are making these changes on an NIS server, you will need to run 'make services' from the 
/var/yp directory to push the changes out to NIS clients.

These entries tell the platform adapters which TCP port to open for communications with 
NerveCenter Servers. If the required entry or entries is absent, the platform adapter will exit on 
startup with an Accept Socket Error.
NerveCenter 4.0.3 Release Notes 9



Installation
Upgrading to NerveCenter 4.0.3
The following sections describe the different upgrade paths you must take when installing 
NerveCenter 4.0.2 over existing versions of NerveCenter.

Upgrading from NerveCenter 3.8 or Previous Versions

Upgrading from NerveCenter 4.0

Upgrade Information for MS-Access Users

Upgrading from NerveCenter 3.8 or Previous Versions
NerveCenter 4.0.3 components are not compatible with older NerveCenter components. For 
example, a 3.8 NerveCenter client will not connect with a NerveCenter 4.0.3 server. You 
must upgrade all NerveCenter components at the same time, including integration 
components such as ovpa, semsopca, and paserver.

If you are using an Access database on Windows, you must serialize your existing database 
before you upgrade to NerveCenter 4.0.3. If you do not serialize your database before 
installing NerveCenter 4.0.3, you will need to reinstall the old version of NerveCenter to 
serialize your database.

You must uninstall your 3.8 or older version of NerveCenter before installing NerveCenter 
4.0.3. 
NerveCenter 4.0.3 Release Notes10



Upgrading to NerveCenter 4.0.3
Upgrading from NerveCenter 4.0
When upgrading from NerveCenter 4.0, you can follow the instructions in Upgrading NerveCenter 
and Installing NerveCenter to install a completely new version, or you can install over your existing 
version of NerveCenter.

INSTALLING NERVECENTER 4.0.3 OVER AN EXISTING NERVECENTER 4.0 INSTALLATION (UNIX)

1. Run the installation script as described in Installing NerveCenter.

If you are installing over an existing version, the script asks where you want to install 
NerveCenter and displays the current directory. 

2. Accept the current directory as your installation directory and press Enter.

The script then asks whether you want to upgrade the existing files or install and leave the 
existing files untouched. For a typical upgrade, you would choose the first option—to 
upgrade files to NerveCenter 4.0.

3. Choose the upgrade option and press Enter.

The script then lists the components currently installed. You can add more components to 
your installation by typing the corresponding letter for each.

4. Choose any additional components by typing the corresponding letter for each and pressing 
Enter. If you don’t want additional components, just press Enter.

The script continues to display the currently-installed options with each prompt. Make 
changes as appropriate for your upgrade.

After Setup has completed successfully, you are ready to start NerveCenter.
NerveCenter 4.0.3 Release Notes 11



Installation
INSTALLING NERVECENTER 4.0.3 OVER AN EXISTING NERVECENTER 4.0 INSTALLATION 
(WINDOWS)

1. Run the installation program as described in Installing NerveCenter.

2. Specify your installation options when the installation wizard prompts you for them.

If you are installing over an existing version, Setup displays the currently-installed options. 
If not, Setup displays a default with each prompt.

NOTE
When asked whether you want DBWizard to set up your database after installation, 
leave the default selection of No.

Setup installs NerveCenter, using the options you specified.

Upgrade Information for MS-Access Users

CAUTION
Windows users that run NerveCenter with an MS-Access database must serialize 
their data before upgrading to NerveCenter 4.0, because version 4.0 of the 
SerializeDB utility does not serialize version 3.8 data.

UPGRADING TO NERVECENTER 4.0.3 WITH AN MS-ACCESS DATABASE:

1. Before starting the NerveCenter upgrade, serialize your NerveCenter MS-Access database 
using SerializeDB.

2. As with any software upgrade, back up your database.

3. Uninstall your old version of NerveCenter.

4. Install NerveCenter 4.0.3.

5. Use DBWizard to create a NerveCenter 4.0.2 database and to load the serialized file you 
created in step 1.

For more information, refer to Upgrading NerveCenter.
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Upgrading to NerveCenter 4.0.3
Serial Numbers (License Keys)

The serial number (license key) you will need to operate NerveCenter depends on the following 
scenarios:

If you have just purchased or are evaluating NerveCenter, please use the serial number 
provided by your Open representative.

If you are on maintenance and are upgrading to NerveCenter 3.8, your existing serial number 
(license key) will continue to work.

If you are a current NerveCenter user but not on maintenance, you will need to purchase an 
upgrade with maintenance by calling the Open Customer Administration Services group at 
1-888-886-1085 ext. 3.

NOTE
Four characters are not used in NerveCenter serial numbers. These characters are: 0 
(zero), 1 (one), 5 (five), and Q.

NOTE
WebCollector connections to a NerveCenter Server do not require an additional 
client connection license. 
NerveCenter 4.0.3 Release Notes 13



New Features and Fixes
New Features and Fixes

The following table describes the fixes in NerveCenter 4.0.3.

TABLE 1-2. Fixes in NerveCenter 4.0.3 

Tracking Number Description

19208 Fixed timing of the Protocol Manager's handlers for timeouts/retries 
and error responses. 

Fixed implementation of the "nl-ping" scalar group.

18961 Fixed paserver.

18753 Fixed Inform queuing in OVPA.

18740 Fixed NerveCenter web client.

18780 Fixed Client connection issue with Active Directory.

18679 Fixed error in ncserver where managing or unmanaging a large 
number of nodes caused ncserver to crash.

18589 Fixed error with SNMP SET in ncserver.

18512 Fixed error with ncserver and log to file.

18522 Fixed error in ncserver with Clear Trigger.

18500 Fixed error in ncserver with startup.
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Upgrading to NerveCenter 4.0.3New Features and Fixes
The following table describes the fixes in NerveCenter 4.0.2.

The following table describes the new features of NerveCenter 4.0.

TABLE 1-3. Fixes in NerveCenter 4.0.2 

Tracking Number Description

16728 

17640

Fixed the delta() function for all SNMP v1 and v2 varbind types.

16732 

17180

Fixed Send Trap action.

17682 

16445 

17855 

17868

Fixed ncserver logic.

17572 Improved OVPA performance.

17649 Fixed OpenView trap source issue.

17681 Fixed polling issue.

17714 Fixed memory management issue in ncserver.

17869 NerveCenter events are now relayed to OpenView when NerveCenter 
is the trap source.

17867 

17907

Fixed SMTP Mail Action.

17919 

UNIX only

Fixed .ncdb file limitation. ncserver can now read .ncdb files with 
lines containing more than 4000 characters.

18261 

18226

Windows only

Fixed excessive growth of the database.
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New Features and Fixes
TABLE 1-4. New Features in NerveCenter 4.0 

New Feature Description

Multiple Perl Interpreters In prior versions of NerveCenter, there was one Perl interpreter and 
that interpreter was single threaded. This meant that only one poll, 
trap mask function, Perl subroutine, or action router rule could run at 
one time. Perl scripts that take a long time to run, such as logging to a 
file, performing database queries, or issuing external system calls, can 
slow down NerveCenter’s performance. 

NerveCenter 4.0 gives you the option of using separate Perl 
interpreters for the three major components in NerveCenter which use 
Perl—poll conditions, trigger functions, perl subroutines. Action 
router rules and OpC trigger functions continue to use a global—or 
shared—Perl interpreter. 

Upgrading Perl in Upgrading NerveCenter describes this new Perl 
architecture in detail.

OVPA OVPA has a new argument, -preferredAddrOnly, which limits the 
SNMP addresses sent from OVPA to NerveCenter during resync.

ovpa in Managing NerveCenter describes this feature in detail.

IP and Hostname Filters You can now filter by hostname when importing nodes from a node 
list or network management platform. You can also chose whether or 
not to apply IP and hostname filters when importing node lists.

Filtering Nodes in Managing NerveCenter describes here features in 
detail.

Disable DNS Lookup To improve NerveCenter performance, you can now disable the DNS 
lookup of discovered nodes. Additional improvements have been 
made to improve the efficiency of DNS lookups when these queries 
are in effect. When a large number of traps are received in a short 
period from an unknown address to be discovered, NerveCenter will 
not queue multiple DNS lookups of the same address.

Adding Nodes Discovered from Traps in Managing NerveCenter 
describes this feature in detail.

Username and Password 
Required

NerveCenter now requires a username and password when you 
connect to a Client or Administrator, even on Windows installations.

AuditTrail.log Introduced in NerveCenter 3.8, NerveCenter records changes to 
behavior model components to AuditTrail.log. This log can assist 
when debugging behavior models.

Behavior Model Log in Designing and Managing Behavior Models 
describes this feature in detail.
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Upgrading to NerveCenter 4.0.3New Features and Fixes
Revised Built-in Triggers The built-in triggers INFORM_CONNECTION_DOWN and 
INFORM_CONNECTION_UP now monitor the connection to 
paserver as well as the connection to OVPA.

Updated Microsoft SNMP Trap 
Source (MSTRAP)

NerveCenter 4.0 supports WinSNMP, an updated Microsoft SNMP 
trap service. This updated trap service supports SNMP v2c traps.

SEMSOPCA depreciated The SEMSOPCA binary in NerveCenter 4.0 is provided for historical 
purposes only. It is depreciated and not supported.

Mibcomp37 If you are upgrading from prior versions of NerveCenter, Mibcomp37 
is provided for use with your old MIBs. Using Mibcomp37 in 
Upgrading NerveCenter describes this feature in detail.

Mibcomp37 is not installed on Linux platforms.

Revised Help NerveCenter 4.0 includes new, revised help. This help system is 
HTML based and requires a browser to view.

To view the help on UNIX, you must specify a path to a supported 
web browser when installing NerveCenter. See Installing 
NerveCenter on UNIX in Installing NerveCenter for details.

If you are using Internet Explorer 6, you must configure Active 
Content to run on your machine. Select Tools > Internet Options > 
Advanced > Security. You must enable the following option for the 
search to work: Allow active content to run in files on My 
Computer.

TABLE 1-4. New Features in NerveCenter 4.0  (Continued)

New Feature Description
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Outstanding Issues
Outstanding Issues

The table below lists all the known problems in NerveCenter v4.0.2.

TABLE 1-5. Outstanding Issues in NerveCenter 4.0.2 

Issue Description Win Linux HP-UX Solaris

Compatibility issue 
between 4.0 and previous 
releases

NerveCenter 4.0 is incompatible with previous 
releases of NerveCenter. There are changes to the 
software that prevent this version from 
interpreting with earlier releases of NerveCenter 
installed on other machines. Update all systems to 
NerveCenter 4.0.

MSTRAP requires 
Windows XP or 2003 
wsnmp32.dll

If you are using MSTRAP as your trap source, 
you must use the 
\%SystemRoot%\System32\wsnmp32.dll 
provided with Windows XP and Windows 2003.

If you are using Windows 2000 and want to use 
MSTRAP as your trap source, you must upgrade 
wsnmp32.dll. 

Behavior models not 
intended for production

The behavior models provided with NerveCenter 
are for demonstration or example purposes only, 
and are not intended for production.

Cannot fire trigger if use 
AssignPropertyGroup() 
perl function in trigger 
function or poll condition

Use of the AssignPropertyGroup() perl function 
in a mask trigger function or poll condition 
appears to prevent any triggers being fired in the 
same trigger function or poll condition for that 
node.
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Upgrading to NerveCenter 4.0.3Outstanding Issues
File Table Overflow error 
with HP OpenView 7.0

If NerveCenter is running on HP-UX 11.0, co-
resident with HP OpenView Network Node 
Manager and you encounter the error file table 
overflow, you need to increase the kernel 
arguments nproc and nfile on the HP-UX 11.00 
machine to make sure HP OpenView 7 and 
NerveCenter can work properly.

Client hanging or freezing From NerveCenter client, in the Connect to 
Server window, after you enter the connection 
information (Server Name, user ID, and 
Password) and click Connect, the client may 
freeze. 

If you have autoconnection set up in client, the 
client may hang before you can see the Aggregate 
Alarm Summary window. 

If you experience the above on HPUX11 machine, 
please check if you have the following patch 
installed: 

XSWGR1100.PHSS_21493.X11R6-SHLIBS 
which would install the following libX11.3 
library: 

1458176 Apr 3 2000 /usr/lib/X11R6/libX11.3 

If you do have the patch PHSS_21493 installed, 
you can either roll-back the patch, or go to HP 
web site and download the free QPK patch bundle 
QPK1100 B.11.00.62.4 Quality Pack for HP-UX 
11.00, September 2003. The patch bundle will fix 
the freezing problem. QPK1100 B.11.00.62.4 
includes the patch PHSS_27230 which installs the 
following libX11.3 library:

1409024 Jun 7 2002 libX11.3 

The browser path must be 
entered correctly the first 
time NC is installed

When installing the NerveCenter Client and or the 
NCadmin the user is asked for a path to the 
browser. If this is not entered the during the first 
installation a subsequent installation will not 
correct the problem. The workaround is to 
uninstall and reinstall with the correct path the 
first time. 
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Outstanding Issues
Installation of NCserver 
only on Win2k results in 
message about registry 
permission 

If you install the NerveCenter Server without the 
client and/or the ncadmin on Win2k then you will 
see two dialog boxes complaining about not being 
able to set registry permissions for the NC admins 
group and the NC users group respectively. This 
will not affect the behavior of the product. 

SerializeDB import file 
types operate on both file 
types but only one is 
selected 

The NerveCenter utility, SerializeDB, has an 
Import file to database option that enables you 
to import only .asc file types; however, 
SerializeDB will allow you (incorrectly) to also 
select .ncdb file types for import without 
displaying an error.

Some users might incorrectly think that the .ncdb 
file SerializeDB allowed them to select was 
actually imported. 

Error message displays 
when disconnecting from 
a remote Server 

When disconnecting a NerveCenter Client from a 
remote connection to a Windows server running 
an Access database, the following error message 
displays on the Client:

Can't remove system datasource

This message has no effect on the NerveCenter 
database; no data is lost.

TABLE 1-5. Outstanding Issues in NerveCenter 4.0.2  (Continued)
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Upgrading to NerveCenter 4.0.3Outstanding Issues
Severities of nodes in 
node list do not show 
highest severity of current 
alarms 

Nodes appearing in the node list should reflect the 
highest severity level of all of the alarms that have 
transitioned for that node. For example, if an 
alarm transitions a node to a Critical Severity but 
then another alarm transitions the node to a Minor 
Severity, then the aggregate severity for the node 
that appears in the node list should be Critical. In 
reality, the aggregate severity of the node in the 
node list changes to Minor. NerveCenter does not 
correctly track terminal states of alarms when 
those states have no outbound transitions.

The workaround is to:

Create a mask with a simple trigger called 
No_op. 

Save the mask and turn it off.

In all affected alarms, add a transition to the 
last state in the diagram. The new transition 
should loop back to that state on the No_op 
trigger (i.e., the from and to states should be 
the same).

Configuration settings 
lost during upgrades 

When upgrading from NerveCenter 3.7 or 3.8 to 
4.0 on UNIX systems, users (other than root) lose 
their Client and Administrator settings. The 
NerveCenter installation script does not translate 
user settings in the registry to an XML file, so 
things like autoconnect servers, alarm filters, and 
so on are lost for any users other than root.

TABLE 1-5. Outstanding Issues in NerveCenter 4.0.2  (Continued)

Issue Description Win Linux HP-UX Solaris
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Outstanding Issues
Server logs incorrect data 
for subobjects that are 
only partially supported in 
a polled agent's MIB 

When NerveCenter polls an agent for more than 
one columnar object in a table—and the first of 
these objects has more instances in the table than 
the secondary object has—then “ghost” data for 
the missing instances of the second columnar 
object is logged to the log file if you have a Log-
to-File action on the polling transition.

The workaround is to create an alarm that will 
transition out of ground on the table's index. In 
this way the user can poll (either separately or 
together) for the other attributes (outErrors, 
ifdescr) and use SNMPNOSUCHNAME to 
determine when the poll has reached the end of a 
row.

NetCool probe reports 
“Seagate Nerve Center” 
instead of Open 
NerveCenter

The NetCool probe reports NerveCenter informs 
to NetCool as coming from Seagate NerveCenter 
instead of Open NerveCenter. This is a NetCool 
problem.

IIS 5.0 or above issue 
with Web Collector. 

The path to the NerveCenter CGI files is always 
defaulted to /program 
files/openservice/nervecenter even 
if the user installs NerveCenter using a different 
path. As a result, the user is unable to connect to 
the Webcollector. This only happens on a machine 
running Microsoft Internet Information Server 
(IIS).

NerveCenter terminates 
with an error when the 
NerveCenter Service is 
stopped 

When the NerveCenter Service is stopped, it 
terminates and sends the following message to the 
Windows desktop:

ncserver.exe - Application Error

The instruction at "0x7800d0b9" referenced 
memory at "0x00000005". The memory could not 
be "written".

Click on OK to terminate the application

TABLE 1-5. Outstanding Issues in NerveCenter 4.0.2  (Continued)
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Upgrading to NerveCenter 4.0.3Outstanding Issues
Open modal dialog boxes 
appear to restrict activity 
in Client 

On UNIX, NerveCenter Client appears to lock up 
if you are editing an alarm transition and click 
elsewhere within the main window while the 
alarm transition dialog box is still open.

If you're running CDE, modify the GUI settings 
from the toolbar. Select Window settings, turn off 
“Allow primary windows on top,” then respond 
Yes to restarting your window manager. The 
dialog box now remains on top, forcing you to 
make any changes you need and select OK before 
attempting to use other elements.

Using the import model 
browser

If you choose to instead link the model directory 
to another location, make sure the other location 
is not a parent directory of NerveCenter (/opt 
and /opt/OSInc by default).

If this occurs, NerveCenter Client’s browse 
feature (off of the Import Objects and Nodes 
dialog) will not be able to browse to your models, 
popping up an error dialog reading ‘no files 
found’.

Log To Database log 
maintenance is not 
working correctly 

Truncation of records from the log tables is not 
occurring at a reasonable point.

CLI incorrectly displays 
node severity information 

The NerveCenter Command Line Interface (CLI) 
incorrectly retrieves information about node 
severity. The information displayed through the 
CLI does not match severity information 
displayed in the NerveCenter Client’s Node List 
window.

Paserver not designed to 
connect with OpenView 

The NerveCenter Universal Platform Adapter 
(paserver) terminates when an OpenView Inform 
connection is made to it. The error is:

Run-time exception error; current exception: 
xalloc No handler for exception.

Paserver is not designed to handle OV informs, 
however, it is a very easy mistake to create the 
inform connection in the NerveCenter 
Administrator and forget to click the 
Netcool/Tivoli radio button.
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Outstanding Issues
NerveCenter unable to 
support eight-bit character 
sets used for 
internationalization 

UNIX platforms require applications to set the 
LANG variable to a national locale for 
applications to be able to support eight-bit 
characters used in languages such as French and 
Spanish.

However, since all Open NerveCenter 
applications, and in particular, the ncserver 
process, does not run if the LANG variable is set 
to anything other than C, the variable binding 
information in a trap is not interpreted correctly 
when there are any eight-bit characters.

NerveCenter issues 
SNMP GETs for 
mismatches between a 
poll’s base object and an 
alarm’s subobject 

NerveCenter issues SNMP GETs for polls even 
when there’s a mismatch between a poll’s base 
object and the associated alarm’s subobject.

When an alarm’s subobject (SO) does not match 
the poll's base object, the relevant trigger fired 
from the poll will never match the alarm’s SO.

CLI displays duplicate 
server information 

When using the NerveCenter Command Line 
Interface (CLI) and when more than one client is 
connected to the same server, issuing the 
command:

show server -c

causes NerveCenter to display information about 
the first server twice.

Client (sometimes) 
abnormally terminates 
and dumps core when 
attempting to edit an 
alarm 

When attempting to edit an alarm, upon first 
opening the alarm the NerveCenter Client may 
crash and dump core. This does not happen all of 
the time, but it does happen often enough to be 
reproducible.

Client not properly 
notified of 
AutoClassification status 
on server startup 

When the NerveCenter Server is auto classifying 
nodes at the time a NerveCenter Client connects, 
the connecting Client does not get an 
Autoclassify in progress... status 
bar message. 
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Upgrading to NerveCenter 4.0.3Outstanding Issues
Administrator SNMP Poll 
Port feature not working 

On the NerveCenter Administrator’s Ports page, 
the SNMP Poll Port field enables you to specify 
the default port on the node used to communicate 
with SNMP agents. This feature is not working in 
version v4.0.

Repeated mouse clicking 
causes Client to 
abnormally terminate 

When one performs actions in the NerveCenter 
Client that requires repeated mouse clicks, the 
Client can abnormally terminate.

Custom severities are 
unreadable if light colors 
are chosen 

NerveCenter uses white text automatically for all 
user-defined severities. If light colored 
backgrounds are chosen, severity text will not be 
readable. For pre-defined severities, NerveCenter 
is configured to use black text with light colored 
severities.

No varbinds sent when 
ICMP_ERROR fired 

When the trigger ICMP_ERROR is fired after an 
SNMP poll, the trigger does not include variable 
bindings, such as uctype and uccode, that might 
be useful for determining the cause of the error. 
Currently, the trigger is fired along with 
PORT_UNREACHABLE, 
NET_UNREACHABLE, and/or 
NODE_UNREACHABLE triggers. (Varbinds are 
included when the trigger is fired after an ICMP 
poll.)

Some ICMP_ERROR 
codes are incorrect 

When the trigger ICMP_ERROR is fired, a few of 
the ICMP error codes are reported in log files with 
the type and code pasted together. For example, a 
uctype=5 and uccode=2 results in an error code of 
52, whereas the error code should be 2.

NerveCenter concatenates values for the 
following types and codes:

uctype = 5 with error codes 0, 1, 2, and 3

uctype = 11 with error codes 0 and 1

uctype = 12 with error codes 0 and 1

If you attempt to match nl-ping-uctype=5 and nl-
ping-uccode=2 in a Perl subroutine or poll 
condition, the condition is not matched because 
NerveCenter returns an incorrect value. 
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Outstanding Issues
Client Window menu lists 
non-existent untitled 
windows 

Extra windows are listed in the NerveCenter 
Client's Window menu. Windows that are actually 
open are listed correctly after the extra ones.

Ipsweep ignores Ctrl C When running the ipsweep process, you must 
convert ipsweep to background (Ctrl Z) before 
you can kill the process. You can not stop ipsweep 
with the Ctrl C command.

Variables listed in 
command actions must be 
preceded and followed by 
whitespace 

When creating a command action for an alarm 
transition, you can not include a subobject 
variable after a base object. Placing a punctuation 
mark behind the base object variable causes that 
variable to be left out when processing the 
command. 

For example: echo $NodeName 
$TriggerBaseObject.$TriggerInstan
ce > /tmp/test

Should return something like the following:

NodeName system.0

Actually, it returns the following:

NodeName .0

Workarounds for this example are: echo 
$NodeName $TriggerBaseObject 
$TriggerInstance  
$TriggerBaseObject >>/tmp/test1

echo $NodeName $TriggerBaseObject 
'.' $TriggerInstance 
$TriggerBaseObject >>/tmp/test1

Two clicks are required 
for commands in the 
Transition Definition 
dialog box 

When creating a transition for an alarm definition, 
after you open the Transition Definition dialog 
box, you must click any button two times (New 
Action, OK, Cancel, Help) before the command is 
activated.
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Professional Services
Open Technical Support 

Open is committed to offering the industry's best technical support to our customers and partners. 
You can quickly and easily obtain support for NerveCenter, our proactive network management 
software, or Security Threat Manager, our security threat management suite.

Professional Services

Educational Services

Contacting the Customer Support Center

Professional Services
Open offers professional services when customization of our software is the best solution for a 
customer. These services enable us, in collaboration with our partners, to focus on technology, 
staffing, and business processes as we address a specific need.

Educational Services
Open is committed to providing ongoing education and training in the use of our products. Through 
a combined set of resources, we can offer quality classroom style or tailored on-site training.

Contacting the Customer Support Center
For telephone support

Phone: 1-888-886-1085, menu option 1 or 1-508-599-2000
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Open Technical Support
For e-mail support

E-mail: techsupport@openservice.com.

For electronic support

Open has a Web-based customer call tracking system where you can enter questions, log problems, 
track the status of logged incidents, and check the knowledge base.

When you purchased your product and/or renewed your maintenance contract, you would have 
received a user name and password to access the Open Call Tracking System using TeamShare.

If you have not received or have forgotten your log-in credentials, please e-mail us with a contact 
name and company specifics at techsupport@openservice.com.

We are committed to providing ongoing education and training in the use of our products. Through 
a combined set of resources, we offer quality training to our global customer base.

For Online KnowledgeBase Access

For additional NerveCenter support information, please go the Open website 
http://www.openservice.com for access to the following sections of information:

Patches and Updates - latest installation files, patches, and updates including 
documentation for NerveCenter.

Software Alerts - latest software alerts relative to NerveCenter.

KnowledgeBase Search - search the NerveCenter KnowledgeBase for answers to your 
questions whether relating to the installation, usage, or operation of NerveCenter.
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